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Abstract: In today’s technological world, every manmade purpose is turbinated as feast of automation and innovation through
scientific inventions that are made by humans. These inventions are used to reduce workload of man power in any industry. So on
the similar criteria, we have designed an automatic line tracking robot for patrolling the behaviors of students inside the class and
lobby. Due to this patrolling system there is no need of any professors or higher authorities need not to watch and monitor the
student behavior on the lobby. We are using authentic traditional AGV (Automatic Guided Vehicle) methodology along with this
we also fastening currently developed technologies like Arduino UNO R3 SMD Atmega328P Board, infrared sensor, ultrasonic
sensor and DC motor for running the vehicle. IR Transmitter and Receiver are connected beneath the chassis; a black and white
LED’s which are used to follow the predefined path of the robot by tracking the black insulation tap line. The ultrasonic sensor
(SRF04) is the used to detect the barriers which are sensible within 2-3 cm. Arduino UNO is the heart of AGV Robot which control
the function of dc motor and sensor modules like IR sensor and Ultrasonic sensor in the robot that fetch those data transmitted by
sensors and operate the robot according to their respective commands through manmade hardware program. A tripod camera holder
is also available to invigilate the circumstances on lobbies which are directly connected through mobile phone to some web App to
the higher authority members that they can monitor the lobbies from their sitting places and no need to come to every respective
class. In this paper, we have embellished the design and implementation of AGV robot for patrolling in lobbies to effectively reduce
the monitoring work for professors in college.

Keywords: Arduino Atmega328P, Ultrasonic sensor, AGV, Patrolling system, IR Sensor.

l. INTRODUCTION

In this paper, we have designed an AGV robot which are forerunners of line follower robot. They are self-Reliant robot
that tracks the patched black path in the ground. First of all we need to develop a power supply source for our robot. An IC regulator
is used to step up the ac voltage for required voltage amplitude. We use RC filter for voltage regulation and three terminal voltage
regulator converts the unconstrained dc voltage to constrained dc voltage. We also using precision rectifier to gain peak voltage
output. In our power supply we are using 78 series which has fixed negative regulated voltage range from 5 to 24. When the robot
is driven on path lane, DC motors follows IR sensor signal to move forward and reverse in ease of control. For managing robot,
relay switches are provided and are coupled with transistors for maintaining low range voltage output. Depends on relay position
the motor directions are decided and mostly we are preferred smaller motors with high strength permanent magnets for line tracking
robot. We are also using arduino coding which is a prototype platform which can be connected through USB cable to load a new
program by programmer. Based on No of inputs, outputs, sensors, LED’s and buttons the arduino board is selected. Our arduino is
directly run from the batter from the range of 3.7 to 5 V. So we are using the Atmega328 microcontroller for this project. The IR
sensors is attached the below the chassis which are placed straight line to each other. In this sensor LM358 operational amplifier is
used for conducting non reversing input voltage is lower than reversing input. Finally ultrasonic sensor supplies a short trigger of
10us pulse where 40 kHz cyclic echo line is produced and effectively measures the object distances within 3 cm and range
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calculation can be done in both centimeter and Inch. The tripod has Wi-Fi connection which are compiled with android phone to
monitor the college lobbies efficiently and share the information through A-power app to another device.

1. CHASSIS OF ROBOT

A chassis is nothing but the body of the robot. The robot body is made of ESS Steel obtain a rigid base. The
aluminum is light weighted and strong enough to hold the maximum weight on the robot. The chassis are durable and reliable to
hold the components like arduino board, battery and battery holder and frames are constructed in such way to carry the power supply
and cables connection in jumper wires (Fig 1). The weight balance of tripod and battery on chassis are well balanced. The frames
are fixed under chassis which holds four wheels and a dc motor.

Fig 1 chassis of the Robot

1. TRIPOD (CAMERA HOLD)

We are using the tripod for holding the camera. The tripod is fixed on the base of the robot chassis which are light
in weight. The Gpron tripod was provided with camera holder at top, where we can hold any android phones and are connect through
Bluetooth or WIFI from one phone to another. These unfolding high selfies stick stand are compatible to use, which have various
extendable height range from 186mm to 680mm with horizontal rotation in 360°and vertical rotation in 180° angels to flip flop
rotation of android phones that are freely adjustable for best angel (Fig 2). We using an online application name A-power App
which is a cast mirroring app used for sharing the live footage directly to higher authority and staffs through mobile phone and Wi-
Fi connection. We can also use video recorder option to record the video and documented them and send it to higher authorities of
colleges.

Fig 2 Tripod attached with chassis

V. AGVY METHODOLOGY FOR ROBOT

The AGV (Automatic Guided Vehicle) is used in many leading Industries. These unmanned vehicle is run by line
following technology, where black insulation tap is patched on the floor or black paint is coated on the lobby. With the help of IR
sensor the robot will track the black lines on the floor. The length of our lobby is 1250 centimeter and we have 6 subdivisions in
the lobby. Those interruption have a distance of 25 centimeter and those 6 subdivision doesn’t have any black lines between them.
So hear the arduino coding is used to move forward the motor and 10 sec is taken to take off the robot from the lane (Fig 3). And
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where ever the black line is patched the robot and after 10 sec it starts to move on track by fetching instruction arduino program.
Once the robot reaches the black trail, AGV concept is applied to run robot on lane. We have colored the line with black paint on
our lobby and back path of robot is merely a possible one by patching the insulation tap in clockwise and anticlockwise round on
each ends on the lobby in our college.

Fig 3 Robot tracking black line like AGV

V. AGV ROBOT FOR PATROLLING AND MONITORING

We have designed an AGV robot that can follow the patched black line on the floor. These are used for patrolling in
anywhere in the lobbies. The tripod is bolted on the body and a camera is fixed on the holder. The camera captures the video which
are shared through screen mirroring app named as “A-power app”. These app is used to connect both the android phones through
WIFI and Bluetooth (Fig 4). We have provide 7800 series IC regulators which are in-built inside the power supply. The power
supply is used to control the variance in voltage range from 3.3 V to 5 V. The Rectifier is used to rectify the ac voltage into single
dc voltage. These power supplies are the base to operate the L293D motor driver, LM398 op-amp, Arduino UNO board along with
sensors and battery.

T

Fig 4 AGV Robot for Patrollir-l*g and Monitoring

VI.  WORKING OF AGV ROBOT

The function of our AGV robot is similar to all robots that exit in AGV methodology. The main source of the robot
is infrared proximity sensor, which are placed under the robot to track the black line. There are four types of working procedure
takes places where the black lines are helpful to track the line (Fig 5). The first case is when the IR proximity sensor detects the
black line trajectory the dc motor run forward and moves the robot ahead of the track. The second case is while the robot wants to
turn right or left, either sides of the sensor will activate. By optimizing the sensing width of the sensor we can capable to hold the
robot on the track. The third case is either of IR sensors will not work then the robot takes the decision of arduino programming.
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Where the black surfaces are not found then dc motor runs through arduino coding programmed by programmer and they hold for
10 sec to record video form outside of class rooms in the lobby and AGV robot’s top view is projected (Fig 6). The forth case is the
when the grey or white surface screened down and arduino command finishes the motor stops running and the robot ends.

Fig 5 working of robot Fig 6 Top view of the robot

VIL. DC MOTORS

These dc engines are exceptionally simple to utilize and are amicable and viable with arduino board. We utilizing L298N
H-span module and engine driver are installed with voltage controller that are utilized in engine and has a voltage range from 5v to
35v (Fig 7). The dc motor with operating voltage level of 12 V and has a limited speed range of 45 rpm is utilized by AGV robot.
These motors have good durable magnet and they have high withstanding rigidity and low armature inductance to run the motor.

)

Fig 7 DC motor

VIII. L293D MOTOR DRIVER

The motor driver are used in the line follower to control the speed of the vehicle. The L293 Module is used to drive the
motor of the line follower in the forward and reverse direction (Fig 8). They receive the signal from arduino UNO r3 board based
on the instructions passed by the IR sensor. The voltage supplied to motor driver is 5 V and the VSS power supplied is 36 V. The
resister is used because they produce and operate efficiently in low voltage output where the motor driver takes single supply
voltage. We can also say this L 293 D module as dual H- bridge motor driver IC, Which has a capable of functioning dc motor in
bidirectional and also good in enhancing current from the sensor that not alone run the motor along with L 293D motor drive
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Fig 8 L293 D Motor Driver
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IX. IR RECIEVER AND TRANSMITTER

IR sensor is an infrared proximity sensor which radiates light beams commonly that transmits on the floor called as IR
Transmitter. Also IR sensor propagates the IR beams in a form of light that sent in the form of light by the IR transmitter. The
function of IR receiver is to receive the reflected light beams on the floor and this happens only when the transmitted light hits the
black spot in the ground. These IR sensors are used as a non-contact one which need not to touch the floor. Comparator is built with
LM 358 functional intensifier and these comparator are connected with IR sensor. The information terminal is associated IR
collector. The rays are passes by IR Transmitter and are collected by IR receiver for tracking the black line effectively with-out any
interfere (Fig 9). These IR sensor are connected with arduino board to run the AGV robot forward by tracing the black tapped line.
Whenever the IR sensor are connected through arduino the robots motion performance is controlled along with DC motor. When
arduino coding is performed along with motor driver that the function of IR sensor is no more. The IR sensor occupies the minimum
voltage range of + 5 V. This voltage levels are maintained by power supplies and IC regulators. IR sensor comparator yield is GND,
so the observation are instructed to microcontroller or PC. We can able to adjust the sensing width of the sensor and we have
adjusted according to the width of the black line patched on the floor.

Fig 9 IR sensor

X. ULTRASONIC SENSOR

We have intended to be similarly as simple to use as the Polaroid sonar, requiring a short trigger heartbeat and giving a
reverberation beat. Your regulator just needs to time the length of this heartbeat to track down the reach. These ultrasonic sensor
are used to detect the barriers which are beneath 2 meter in the lane. They are main source to protect the robot from damage or
accident while tracking the black line (Fig 10). We have used SFO4 ultrasonic sensor for detecting the low and accurate distances
without fail. We using these kind of ultrasonic sensor for all the line following sensor for detecting obstacles in the lane while the
robot is travelling.

Fig 10 Ultrasonic Sensor

XI. CALCULTION OF ULTRASONIC SENSOR

The sensor gives a reverberation beat relative to remove. The width of the beat is calculated in us and they are separated
by 58 will give you the distance in cm, or partitioning by 148 will give the distance in inches.

There are 6 subdivision, each subdivision has a gap of 30 cm
The SRF04 bounce back sound is 100 us

Overall distance of the lobby is 1250 cm; Stable distance measurement is 2 cm;
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FORMULA

Centimeter = ((microseconds / 2) / 29)

For human obstacle the bounce back sound is 60 us

Centimeter = ((60 /2) / 29) = 1.03 cm

Distance = (Time x speed of sound) / 2

Hear for 1% subdivision time taken by sensor is 30 sec and speed of sound is 29.412 ps
Distance = (30 x 29.412) / 2 =0.435 cm.

For inch, 29.412 / 148 = 0.19 inch.

XIl. ARDUINO UNO BOARD

Arduino is an open-source hardware program which are easy to handle and equip for quick alteration of program. Different
types of Arduino boards are available for various microcontrollers inbuilt in system. Nonetheless, all Arduino boards share one
thing practically speaking which are programmed through IDE software. The divergence pivoted on the quantity of data sources
and results the quantity of sensors, LEDs, buttons in solitary board, pace, waged voltage and edifice factor. The arduino boards are
intended to be inserted and have no programming point of interaction are equipped which we would have to independently purchase.
These Arduino UNO R3 board functions from a 3.7V for operating line follower and other types of board needs around 5V (Fig
11).

R g
Fig 11 Arduino UNO Board

Power USB: Arduino board is functioned by using the USB cable from the PC. Connect the data cable to arduino board
and power it by performing coding operation for our AGV robot.

Power (Barrel Jack): Arduino boards are operated with the help of power supply from 3.3 V to 5 V and are connected
through barrel jack.

Arduino Reset: We reset our Arduino board, we have reset the arduino board in two ways. First, we press the reset button
on the board and next we associates another reset button marked as 5.

PIN (6, 7, 8, 9): 3.3V (6) — Supply voltage; 5 V (7) — Supply voltage; GND (8) (Ground) — There are many GND pins are
available in Arduino board and we can use ground pins for our circuit; Vin (9) is a pin that are used to power the board.
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XII. INTERFACING OF LCD DISPLAY WITH ARDUINO

These LCD display have a basic 16x2 alphameric display. A green colored background is patched with black text. We
have 6 optional 1/0 pin to interface with LCD panel (Fig 12). It works on 4 bit and 8 bit modes. These character 16 x 2 LCD display
works with any type of microcontroller. These circuit diagram shows the connection between the arduino and the liquid crystal
display. The LCD display has 12 pins and they are “RS” pin and “R/W” pin, an enabler, 8 data pins (do-d7), display contrast pin
(Vo), power supply pins (+5V and GND) and LED backlight (+ and -). The arduino coding is given hear for reference where LCD
pins and arduino pins are interface with the according pin point connection.

Fig 12 LCD 16x2 Module

Installing the “liquid crystal” library, we have interfaced the LCD pins like RS, E, d4, d5, d6, d7 and the corresponding
arduino pins are 12, 11, 5, 4, 3, 2 (Fig 13). Now we go for setup program and decide the number of rows and columns and give the
function as “lcd.begin (16, 2)”. Next loop the coding by using the function “lcd.clear ()”. And we start the program by setting the
cursor to particular point by providing function “lcd.setCursor ()”. After main coding’s are finished, we move to next part that’s
print “LINE FOLLOWER ROBOT” by commanding “lcd.print (). Then we want to print the position of the cursor by following
the instruction “lcd.setCursor (). Next, position the rows and columns and then code the characters in second line. For reading the
analog values and print it to display use function “analogRead ()" and again use function “lcd.print () the analog values on the
display. And finally add the delay time for the line follower robot to stop, otherwise the text will blinks continuously we use delay
which will decrease this blinking.

.\(\o
© B
~6 2 VO
2 2 D7
3 -2 D6
4 2 D5
5 - D4
| S5v - VDD
GND 2 Vec, Rw, K
9 S
11 =0 E
12 - Rs (Register Select)

Fig 13 Interfacing of LCD display with Arduino UNO

XIV. INTERFACING OF L293D MOTOR DRIVE WITH ARDUINO

The L293 D motor driver has 16 pins and each pins are located respectively to the notch at the top. We connect the motor
driver with arduino board using jumper wires. First step, we want to connect GND and 5 V and entire connections are given through
breadboard and jumper wires. Connect 5 V to enabler 1, VSS and VS on the motor driver and also intersect the 6" digital output
pin to “input 1 and 7™ pin to “input 2” on driver and then connects the GND pin from arduino board to motor driver. Finally
connect the 1%t and 2" output pins from motor drive to dc motor. The arduino coding is programmed for the line follower when the
black line is not visible on the floor. So now we want to fetch the program for motor driver to operate DC motor and to make sure
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robot runs forward. We have select the correct port under “Tools > Port” and correct board under “Tools > Board”. Click the File
> New, so the new input for the motor drive by replacing them with “motorpinl” and “motorpin2”.

XV. BATTERY

The batteries are fundamental one for power supply in the line following robot, which supplies power to AGV robot for
controlling the dc motor, IR sensor, ultrasonic sensor, motor drive module and arduino board. Lead-corrosive cells are many times
utilized in a series blend of three for a 6-V battery and six for a 12-V battery. The battery is utilized for power supply with least of
+ 5V and most extreme reasonable drifters of 10mv. It is essential that the general framework be improved concerning accessible
energy and nearby interest design (Fig 14). To be financially alluring the stockpiling of sunlight based power requires a battery with
a specific blend of properties like dependability, cost, battery-powered, low release, high effectiveness and has good longevity and
are used for several time by rejuvenate the battery.
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Fig 14 V 7.2 AH SMF Battery

XVI. CONCLUSION

In this paper we have discussed the AGV based patrolling robot which can be used to invigilate and monitor the behaviors
of student on the lobby of the floor and even inside the class room through screen mirroring web developed app from one android
device to another device via WIFI. A tripod is fixed rigidly on the chassis and they hold the android phone or camera for patrolling
the lobby. The black coating or black tap is marked on the floor where the IR sensor will detect those black trace and they track the
path by reflecting black line and refracting white. To accord with modern technology we comprise the arduino coding by inbuilt
microcontroller hardware and connected with ATMEGA 328 pin out. Ultrasonic sensors are also to detect the obstacles in the lobby
to protect the robot vehicle from trash. In our project we used lead acid battery of 12 V connected in series with charge restoring
capacity and also its helps to start the dc motor to run and useful to operate the entire AGV efficiently. We are also working further
to improve the effectiveness of robot vehicle by using rash Perry pi and additional sensor module for patrolling in surveillance too.
As an ethical engineers, we have designed a line tracking robot by implementing the technological aspect of today’s life in
engineering field which can sort out the modern world problems and are useful to uplift the environment with future scope.
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